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INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

7-zip - 7-Zip Copyright: Copyright (C) 1999-2009 Igor Pavlov. Licenses for files are:
7z.dll: GNU LGPL + unRAR restriction, All other files: GNU LGPL. 7-zip License: This library
is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version. This library is distributed
in the hope that it will be useful,but WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
Lesser General Public License for more details. You should have received a copy of the
GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.
unRAR copyright: The decompression engine for RAR archives was developed using source
code of unRAR program.All copyrights to original unRAR code are owned by Alexander
Roshal. unRAR License: The unRAR sources cannot be used to re-create the RAR
compression algorithm, which is proprietary. Distribution of modified unRAR sources in
separate form or as a part of other software is permitted, provided that it is clearly stated
in the documentation and source comments that the code may not be used to develop a
RAR (WinRAR) compatible archiver. 7-zip Availability: http://www.7-zip.org/

AMD Version 2.2 - AMD Notice: The AMD code was modified. Used by permission. AMD
copyright: AMD Version 2.2, Copyright © 2007 by Timothy A. Davis, Patrick R. Amestoy,
and Iain S. Duff. All Rights Reserved. AMD License: Your use or distribution of AMD or any
modified version of AMD implies that you agree to this License. This library is free
software; you can redistribute it and/or modify it under the terms of the GNU Lesser
General Public License as published by the Free Software Foundation; either version 2.1 of
the License, or (at your option) any later version. This library is distributed in the hope
that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser
General Public License for more details. You should have received a copy of the GNU
Lesser General Public License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is
hereby granted to use or copy this program under the terms of the GNU LGPL, provided
that the Copyright, this License, and the Availability of the original version is retained on
all copies.User documentation of any code that uses this code or any modified version of
this code must cite the Copyright, this License, the Availability note, and "Used by
permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice
that the code was modified is included. AMD Availability:
http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2 - UMFPACK Notice: The UMFPACK code was modified. Used by permission.
UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights
Reserved. UMFPACK License: Your use or distribution of UMFPACK or any modified version
of UMFPACK implies that you agree to this License. This library is free software; you can
redistribute it and/or modify it under the terms of the GNU Lesser General Public License
as published by the Free Software Foundation; either version 2.1 of the License, or (at
your option) any later version. This library is distributed in the hope that it will be useful,
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but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies. User documentation of any
code that uses this code or any modified version of this code must cite the Copyright, this
License, the Availability note, and "Used by permission." Permission to modify the code
and to distribute modified code is granted, provided the Copyright, this License, and the
Availability note are retained, and a notice that the code was modified is included.
UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack  UMFPACK
(including versions 2.2.1 and earlier, in FORTRAN) is available at
http://www.cise.ufl.edu/research/sparse . MA38 is available in the Harwell Subroutine
Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at
http://www.cise.ufl.edu/research/sparse . COLAMD V2.0 is also incorporated as a built-in
function in MATLAB version 6.1, by The MathWorks, Inc. http://www.mathworks.com .
COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org ). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3
is a built-in routine in MATLAB 7.1.

Qt Version 4.6.3 - Qt Notice: The Qt code was modified. Used by permission. Qt copyright:
Qt Version 4.6.3, Copyright (c) 2010 by Nokia Corporation. All Rights Reserved. Qt
License: Your use or distribution of Qt or any modified version of Qt implies that you agree
to this License. This library is free software; you can redistribute it and/or modify it under
the
terms of the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version. This
library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies.User
documentation of any code that uses this code or any modified version of this code must
cite the Copyright, this License, the Availability note, and "Used by permission."
Permission to modify the code and to distribute modified code is granted, provided the
Copyright, this License, and the Availability note are retained, and a notice that the code
was modified is included. Qt Availability: http://www.qtsoftware.com/downloads  Patches
Applied to Qt can be found in the installation at:
$HPEESOF_DIR/prod/licenses/thirdparty/qt/patches. You may also contact Brian
Buchanan at Agilent Inc. at brian_buchanan@agilent.com for more information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property
rights in and to the source code, is owned by Hiroshima University and/or STARC.

Errata The ADS product may contain references to "HP" or "HPEESOF" such as in file
names and directory names. The business entity formerly known as "HP EEsof" is now part
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http://www.netlib.org
http://www.netlib.org
http://www.qtsoftware.com/downloads
http://www.qtsoftware.com/downloads
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of Agilent Technologies and is known as "Agilent EEsof". To avoid broken functionality and
to maintain backward compatibility for our customers, we did not change all the names
and labels that contain "HP" or "HPEESOF" references.

Warranty The material contained in this document is provided "as is", and is subject to
being changed, without notice, in future editions. Further, to the maximum extent
permitted by applicable law, Agilent disclaims all warranties, either express or implied,
with regard to this documentation and any information contained herein, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose.
Agilent shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user have a separate written
agreement with warranty terms covering the material in this document that conflict with
these terms, the warranty terms in the separate agreement shall control.

Technology Licenses The hardware and/or software described in this document are
furnished under a license and may be used or copied only in accordance with the terms of
such license. Portions of this product include the SystemC software licensed under Open
Source terms, which are available for download at http://systemc.org/ . This software is
redistributed by Agilent. The Contributors of the SystemC software provide this software
"as is" and offer no warranty of any kind, express or implied, including without limitation
warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be
liable for any damages of any kind including without limitation direct, indirect, special,
incidental and consequential damages, such as lost profits. Any provisions that differ from
this disclaimer are offered by Agilent only.

Restricted Rights Legend U.S. Government Restricted Rights. Software and technical
data rights granted to the federal government include only those rights customarily
provided to end user customers. Agilent provides this customary commercial license in
Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015
(Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial
Computer Software or Computer Software Documentation).

http://systemc.org/
http://systemc.org/
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 Bluetooth DesignGuide QuickStart 
The Bluetooth DesignGuide QuickStart provides an introduction to the content and use of
the Bluetooth DesignGuide for the Agilent Advanced Design System (ADS).

The Bluetooth DesignGuide application package contains various system test benches and
reference designs (for example, an optimal low-IF receiver) for the RF portion of the
Bluetooth physical layer. It allows the investigation of system performance from simple
EYE diagrams, to BER (bit error rate) when impairments such as AWGN, VCO phase noise,
multipath, and/or co-channel, adjacent-channel, intermodulation and pulsed-RF
interference are present. In many cases, the receivers EYE diagram can be observed in
real time during simulation while adjusting the level of the signal or interferer via an
interactive slider.

The DesignGuide also addresses few phase-lock-loop (PLL) and voltage-controlled
oscillation (VCO) design issues and can help you select the best demodulator for your
receiver.

To learn more, refer to Bluetooth DesignGuide Reference (dgblue).

 Using DesignGuides 
All DesignGuides can be accessed in the Schematic window using either the cascading
menus or dialog boxes. Your preferred method can be configured in the Advanced Design
System Main window.

Select the DesignGuide menu from Advanced Design System Main window.

The commands in the DesignGuide menu from Advanced Design System Main window
are as follows:

DesignGuide Developer Studio > Start DesignGuide Studio - This option is only
available if you have installed the DesignGuide Developer Studio. Selecting it
launches the initial Developer Studio dialog box.
DesignGuide Developer Studio > Developer Studio Documentation - This
option is only available if you have installed the DesignGuide Developer Studio.
Selecting this brings up the DesignGuide Developer Studio documentation. You can
also access this documentation by selecting Help > Topics and Index >
DesignGuides > DesignGuide Developer Studio from any ADS program window.
Add DesignGuide - This brings up a directory browser in which you can add a
DesignGuide to your installation. This is primarily used with DesignGuides that are
custom-built using Developer Studio.
List/Remove DesignGuide - This brings up a list of your installed DesignGuides. To
remove a Design Guide, select any you wish to uninstall and choose the Remove
button.
Preferences - This brings up a dialog box that allows you to:

Disable the DesignGuide menu commands (except Preferences) in the Main
window. By unchecking this box, the complete DesignGuide menu and all of it's
commands will be removed in the Schematic and Layout windows.
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Select the interface method you prefer (cascading menus or dialog boxes).

You must close and restart the program for preference changes to take effect.

Note
On PC systems, Windows resource issues might limit the use of cascading menus. When multiple windows
are open, your system could become destabilized. Thus the dialog box menu style might be best for these
situations.

 Accessing the Documentation 

 Accessing Documentation from ADS Schematic Window

To access the documentation for the DesignGuide from ADS Schematic Window, select:

DesignGuide > Bluetooth > Bluetooth DesignGuide Documentation

 Accessing Documentation from any ADS program window

To access the documentation for the DesignGuide from any ADS program window, select:

Help > Topics and Index > DesignGuides > Bluetooth

 The Bluetooth DesignGuide Menu 

The Bluetooth DesignGuide menu, located in the Schematic window under DesignGuide,
provides convenient access to test benches, subnetworks and data displays. It may be
installed as a standalone, or along with other DesignGuides.
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Selecting Bluetooth DesignGuide menu displays the Bluetooth dialog box.

The contents of the Bluetooth DesignGuide menu are divided into several categories:  

Basic System Test Benches. These test benches provide tutorial simulations using
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the Bluetooth RF segment and allow you to evaluate filtering options for the
transmitter.
Component/Subnetwork Evaluations . These simulations are designed to help
you understand and validate many of the built-in subnetworks used in the system
test benches.
VCO/Phase-Locked-Loop (PLL) Investigations. These are simulations of phase-
lock-looped topologies address timing and noise issues.
Multipath Propagation Test Benches. These simulations include multipath models
for investigating system performance under non-ideal indoor propagation conditions.
System Compliance Tests. These system test benches are designed to evaluate
sensitivity and blocking performance.
Medium Rate Radio 1.0 Improvements. These simulations include two modulation
formats for proposed enhancements to Bluetooth radios that allow them to operate at
higher data rates.
WLAN (802.11) Interference. An 802.11 signal source is combined with a
Bluetooth radio to allow investigations of WLAN interference effects on Bluetooth
performance.

For each category, moving the cursor to the right will open a menu displaying the
available items. Each selection (except those beginning with Display) will open a top-level
test bench schematic and in many cases, a data display. The selections beginning with
Display open additional data displays, after the test bench listed above it has opened. You
can also access help, BlueTooth DesignGuide documentation and an About Bluetooth
DesignGuide box from this menu.

 Displaying Simulation Data  
Some test benches have real-time Tk displays that open each time a simulation is
performed. Other test benches automatically open one or more Data Display windows
when selected. In several instances, for example a test bench that is capable of BER
calculations, additional data displays are available. When a Data Display having the same
name as the design has been closed, it can be re-accessed by selecting the Display
Simulation Results option listed on the menu, once the test bench has opened.

 Interactive Simulations 

Some simulations using Tk displays have interactive sliders that allow a parameter to be
adjusted during the simulation. To run a non-interactive simulation where output data is
only collected by sinks, (i.e., time-domain or spectrum measurements), all Tk items must
be de-activated. The TkPowerControl, TkPowerControl2 or TkPowerControl_ForRFOffset
subnetwork must also be de-activated and bypassed with a wire because it contains an
interactive slider.
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 Bluetooth DesignGuide Reference
This section contains application guidelines for using the test benches provided with the
Bluetooth DesignGuide, including:

Basic System Test Benches
Component/Subnetwork Evaluations
VCO/PLL (Phase Locked Loop) Investigations
Multipath Propagation Test Benches
System Compliance Tests
Medium Rate Radio 1.0 Improvements
WLAN (802.11) Interference

For a complete listing of test benches and subnetworks, refer to the section Test Benches
and Subnetworks.

Note
This document assumes a basic understanding of ADS operations. To learn more, refer to Schematic
Capture and Layout (usrguide). For access to the complete set of ADS online documentation, select Help >
Topics and Index from any ADS program window.

 

 Developing or Integrating a Bluetooth Solution
The DesignGuide provides tools for developing or integrating a Bluetooth solution:

Designing a Bluetooth solution - The DesignGuide supplies a reference receiver
design that can be evaluated by comparing the measurements of your RF hardware
and simulations of that RF hardware in an ADS model. Other tools target specific
components of the Bluetooth physical layer. You should review the Basic System Test
Benches, followed by the Component/Subnetwork Evaluations (emphasizing filter
selection) before you begin. The VCO/PLL segment is useful if you are designing a
synthesized source or need to optimize an existing design for good time-domain
performance and phase noise characteristics. Test Benches supporting the newly
proposed modulation formats for medium-rate operation are included. The System
Compliance Tests focus on determining sensitivity and evaluating performance in the
presence of interferers.
Integrating a Bluetooth solution - For integration into a product, such as another
wireless device, handset or any environment with other RF emitters, the DesignGuide
provides simulation-based tools for evaluating system performance under various
conditions. Before you begin, you should review the Basic System Test Benches,
followed by the System Compliance Tests. The Multipath Propagation Test Benches
model various indoor propagation conditions allowing you to observe their effect on
system performance. The WLAN 802.11 Interference test bench ( requires the WLAN
Design Library ) enables you to observe the effect of WLAN 802.11a and 802.11g
interference on Bluetooth performance.
Selected test benches are described in the following sections. For a complete list of
available test benches refer to Test Benches and Subnetworks.
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 Basic System Test Benches  
The basic system test benches provide an introduction to the Bluetooth RF interface. This
section describes some of the main components and subnetworks in the DesignGuide.

  

 Ideal Transmit-Receive EYE Diagram (TEST_EYE) 

This simulation is used to observe the EYE diagram created from the combined effects of a
transmitter and the complete receiver. The system is built with the most basic
components. SHAPED_DATA produces Gaussian-filtered MSK data according to the
Bluetooth specification and an optional Preamble, which consists of the 10101010
sequence, can be included by setting Preamble > 1.

The SHAPED_DATA output is input into an ideal ADS FM modulator component. The
TkPowerControl allows the signal level to be adjusted using an interactive slider.
AWGN_CHANNEL adds thermal noise equal to -174 dBm/Hz to the signal.

Note
SHAPED_DATA, TkPowerControl and AWGN_CHANNEL are all subnetworks created for the Bluetooth
DesignGuide. AddNDensity, a component available in recent releases of ADS, provides similar functionality
to AWGN_CHANNEL but also allows the noise spectral density, in dBm/Hz, to be specified.
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The signal is bandpass-filtered and ideally demodulated.

After scaling and conversion to floating-point, the EYE diagram is displayed on a TkPlot.
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  Transmit Spectrum (TEST_TX_SPECTRUM)

This test bench illustrates some of the filtering options for the Bluetooth transmitter. When
the 8-bit FIR filter is used, images of the spectrum are seen at intervals related to the
sampling rate. Note that because these images are below the phase noise sidebands they
are adequately filtered out.
Additional analysis of the FIR filter can be found by selecting Component/Subnetwork
Evaluations > Transmit Filter (Gaussian FIR) .

  

 VCO/PLL (Phase Locked Loop) Investigations
These test benches provide a set of tools that assist in the design and optimization of
signal sources for a Bluetooth implementation. These basic tools address key performance
requirements. For the full PLL design flow, the ADS PLL DesignGuide is available.

 VCO Response to Frequency Step (TEST_PLL_TR) 

This test bench demonstrates the Bluetooth Fractional-N Synthesizer transient response to
an 80-MHz step. The VCO frequency is 2.4 GHz and the reference frequency is 1 MHz. The
output frequency is Fvco+N or 2.48 GHz. The loop bandwidth, fn, is 5 kHz.
This design, is simulated under the Transient controller using the VCO_DivideByN and
PhaseFreqDet components. The PFD output is coupled to the RC loop filter using the
voltage controlled current source (VCCS). The source frequency must settle to within +/-
20PPM in 200 µ. To understand how to optimize the loop filter, select VCO Parameter
Optimization.
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 Component/Subnetwork Evaluations
Following are details on designs demonstrating component/subnetwork evaluations.

 Channel Filter Impulse Response (TEST_FILTER_IMPULSE) 

This test bench evaluates the impulse response of the Bessel filter used for pulse shaping
in the Bluetooth receiver.
 ADS has two simulation modes: Analog/RF and DSP. This test bench compares the
impulse responses of the circuit (A/RF) and timed (DSP) models, which can be very
similar. The A/RF model has an advantage in that its group delay at the edge of the
passband can be controlled. Using it in a DSP design requires Transient cosimulation,
which can be slower.

 Channel Filter Swept Response (TEST_FILTER_COMPLEX) 
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This test bench sweeps the complex receiver filter model used in the DesignGuide
(FILTER_CHEB_COMPLEX).
Open Data Display TEST_FILTER_COMPLEX. Note that QAM_Demod is set for a gain
imbalance of 0.5 dB and a phase imbalance of 3 degrees. The data display compares the
swept RF response to the balanced condition.

 FM Demodulator Selection (TEST_LOWIF_FMDEMOD) 

An EYE diagram display allows observation of the relative performance of various
demodulators. Due to the different output levels and the amount of residual DC for each
demodulator, select View > View ALL on the Demod_TEST TkPlot to see the EYE diagram.
Demodulator selection is important when designing a Bluetooth solution because receiver
performance is often dependent upon the demodulator's performance. The DesignGuide
provides a choice of several demodulators.
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For descriptions of each demodulator refer to Subnetworks. In the proceeding illustration
DEMFM_BESS_MULT, a delay and multiply polyphase FM demodulator, is notable for its
exceptional performance when compared to other demodulators. An additional test bench,
available under FM Demod Selection w/Channel Filter uses a single complex Chebyshev
channel filter in the receiver, instead of the highpass/Chebyshev/limiter/Bessel signal path
used in TEST_LOWIF_FMDEMOD. Using this test bench puts additional requirements on
the demodulator in exchange for a simpler signal path.

  

 Multipath Propagation Test Benches
Following are summaries of test benches used for multipath propagation.

 Multipath Impulse Response (TEST_MULTIPATH_IMPULSE) 

This test bench evaluates the MULTIPATH_EXPONENTIAL model using an impulse input.
The delay spread profile is shown in the associated data display. Due to the use of a
moving average over 512 symbols, the data display will require several minutes to open
(approximately 2 minutes for a Pentium III at 650 MHz under Windows NT). Select Display
Impulse Response after the schematic is displayed to show the data display window.
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Note
The multipath subnetwork requires a large memory space due to its complexity. Performance will be
reduced on systems having less than 256 MB of RAM.

The MULTIPATH_EXPONENTIAL model implements an exponential power decay multi-path
channel model that is widely used for indoor propagation. The mean excess delay and the
tap delay can be specified in microseconds. Each tap coefficient has a Rayleigh power
distribution, and a uniform phase distribution. For a specified value of time Tburst, the
channel snapshot is kept fixed. For the next Tburst duration, a new channel snapshot is
taken. The tap coefficients for each snapshot, the corresponding values of the RMS delay
spread and the mean excess delay are all available. TK plots for these measurements can
also be enabled.

The tap coefficients are calculated by:
r = exp(-Delay_Tap/Mean_Delay)
a0 = 1/Mean_DelayDelay_Tap, a1= r*a0, a2 = r*a1,......, an = r*a(n-1)

 BER/Outage w/MPath, Noise, No Chan. Filter
(TEST_MULTIPATH_BER_NOFILT) 

This test bench calculates the BER without a channel filter, but includes multipath. It will
usually exhibit ideal BER because the C/N is large (the transmit power is 0 dBm and no
noise is included). The mean delay is larger than for the other multipath test benches,
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being set to 0.2 µ, and the tap delay is 0.05 µ. To observe channel outage, activate
SweepSeed to vary the random seed value used by the Data Flow simulator. A channel
with BER > 0.1% is considered to have caused a failed burst transmission. The simulation
time is approximately 120 seconds (with PARAMETER SWEEP deactivated), for 250 bits
using a Pentium III at 650 MHz under Windows NT with 256 MB RAM.

Note
Simulation time will increase significantly if less than 256 MB of RAM are available.

The preceding figure shows a portion of the output display for multipath (0.2 µ delay
setting) with no channel filter at the output of the ideal FM demodulator. The Clock
Recovery action accepts this distorted input and re-syncs the data. You may wish to vary
this test bench by substituting other non-ideal demodulators, such as the subnetworks
provided with the DesignGuide and observe their performance under multipath conditions.
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 System Compliance Tests

Interferer Type Interferer level
P[dBc]

Wanted signal level, P[dB]>reference
sensitivity

Co-Channel interference, C/I 11 dB 10

Adjacent (1 MHz) interference,
C/I

0 dB 10

Each test bench sets up a starting condition according to Interference Performance
Requirements. Conditions other than these can also easily be specified; for example, the
adjacent interferer offset can be set to 1, 2, 3 or more MHz away from the wanted signal.
An interactive slider provides for attenuating the interfering signal while observing the EYE
diagram. For BER tests, the interactive slider is not used, and the appropriate components
are de-activated as described on the test bench.

The system compliance tests available are:

Combined Co-Channel/Adjacent Channel test
Intermodulation test
Pulsed Interferer with 2nd-order Intercept (IP2) Test Bench.
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The preceding graphics show the EYE diagram and Control Panel for the Adjacent Channel
Interference Test Bench. Moving the slider to the left attenuates the interferer level.
 

 Medium Rate Radio 1.0 Improvements Test Benches
At the time of publication (Version 2.1.1 of this DesignGuide), proposals have been made
to support higher data rates within the framework of the Bluetooth 1.0/1.1 Specification.
Test benches which simulate the two modulation formats under consideration, Pi/4-DQPSK
and 8-DPSK, for 2 and 3 Mbps respectively, are included.

Note
Parameters have been set using the best information available but you are encouraged to obtain the latest
Specifications from the Bluetooth SIG.

 Ideal Pi/4-DQPSK Modem with EVM and BER
(pi4DPQSK_Modem_Ideal) 

This test bench models an ideal 2 Mbps radio with a variable-length GFSK preamble.
Measurements of the modulated signal, such as spectrum mask and EVM are available. In
addition, BER may be determined using a variety of methods. The default configuration
will produce the dataset for the display pi4DQPSK_Modem_Ideal_Mask.dds, which includes
Spectrum Mask, Trajectory, Input/Output Data, BER (short Monte Carlo estimate), RMS
EVM and Peak EVM.
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Some modulation formats, including Pi/4-DQPSK, are compatible with BER estimation
using sampling reduction methods such as Importance Sampling . ADS provides this via
the berIS component. Such methods reduce the BER simulation time by several orders of
magnitude. However, certain guidelines must be followed. In particular, noise sources
internal to the simulation should be set to 0, except for AddNDensity, which should be set
to -174 dBm/Hz. The Receiver noise figure, determined by the variable F, should be set to
0. The berIS component will internally sweep Es/No during the simulation, providing the
noise model. The simulation runs until the Relative Variance, EstVar, is met.



Advanced Design System 2011.01 - Bluetooth DesignGuide

24

When using berIS the symbol error rate (SER) for the I and Q symbols are found
individually. They are combined during post-processing using the following Data Display
expressions. (Refer to the berIS documentation for more information.)

 

 Medium Rate 2 Mbps Sensitivity and BER Test Bench
(TEST_MR2_RECEIVER_SENSIVITY)

This test bench implements the 2 Mbps mode using interactive control to view EYE
diagrams, output data and a real-time BER estimate as the received power is varied via a
slider. The BER_TK subnetwork updates every 500 samples; the first value will be at 500-
Tsave, (e.g., for Tsave =100), the display will update at 400, 900, 1400, et cetera. It may
also be configured for BER using Importance Sampling. The transmitter and receiver are
inside subnetworks, rather than at the top level design. A berMC measurement is also
provided, for determining BER vs. a swept parameter other than Es/No, such as Prx.
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 Ideal 8-DPSK Modem with EVM and BER (8DPSK_Modem_Ideal)

For 3 Mbps operation, 8-state Differential Phase Shift Keying (8-DPSK) has been
proposed. This test bench provides an ideal modem with measurements for Spectrum
Mask, EVM and BER. The radio has a variable-length GFSK preamble, implemented using
an RF switch component to disconnect the GFSK source and connect the 8-DPSK source
when the preamble is ended.

The 8-DPSK modem can be described as follows: Pseudo-random data in binary NRZ (non
return to zero format, +/- 1V) from the timed Data component are differentially encoded
using the BinaryCoder component. The SymbolConverter maps the data to 8-level Pulse
Amplitude Modulated (PAM) symbols; there are 3 bits per symbol. Before the symbols can
be phase modulated onto a carrier, scaling and offset must be applied. The phase
modulator has a sensitivity of 360 degrees/volt. To properly map the 8 symbol levels to
the correct phase-keying states, the input should be between -0.375 V and 0.500 V. The
GainRF component scales the NRZ data by 2/0.875 = 0.4375. The DCShift offsets the
signal by 0.5/8 = +0.0625 V.

Root raised-cosine pulse shaping has also been proposed. In the next two illustrations 8-
DPSK IQ trajectory is first shown without any filtering in the transmitter and then with
filtering applied. For practical rectangular pulse modems, equalization of f/sin(f) is also
applied.
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Raised-cosine filtering limits transitions to the unit circle. For a roll-off factor of 0.4
(proposed), the trajectory appears thus:

AddNDensity provides the channel noise model. The receiver uses clock recovery and hard
decision decoding. The received signal is split to the clock recovery structure and to the
quadrature demodulator. Following ideal demodulation of the I and Q parts of the signal,
root raised cosine filters are applied. The clock recovery uses the GFSK preamble
(alternating 101010.... pattern) to extract the clock, which is used to clock the I and Q
SampleAndHold components. The Quantizer2D forces the sampled points to the nearest
points on the 8-PSK constellation. This signal is applied to the PM_Demod. The PM_Demod
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output is inversely scaled and applied to a SymbolConverter set for PAM8 input and NRZ
output. The BinaryCoder performs differential decoding to fully recover the output data.

Measurement taps are provided to send input and output data, encoded input and output
symbols, spectrum and trajectory data to the dataset. The display
8PSK_Modem_Ideal_Mask shows all of these signals. Of particular interest is the
recovered clock signal, on display page 2, and the encoded input and output symbols
overlaid.

EVM and BER measurements are provided. BER is performed using the berMC component.
Sampling reduction methods (such as Importance Sampling ) are not applicable to
constant-envelope modulation such as 8-DPSK. The berMC component will now control the
simulation until EstRelVariance is achieved. It is not necessary to determine in advance
how many samples are required for an accurate BER estimate. This is different from other
test benches in the Bluetooth DesignGuide which have a "Numbits" variable to set the BER
simulation length as a function of a swept parameter.

Of particular interest is the relation between the filter roll-off factor (variable BT) and error
performance. It can be shown that a roll-off of 0.4 is not sufficient for acceptable
performance; BT should be 0.60 or larger for best performance.
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 Medium Rate 3 Mbps Sensitivity and BER Test Bench
(TEST_MR3_RECEIVER_SENSITIVITY) 

This test bench implements the 3Mbps mode using interactive control to view EYE
diagrams, output data and a real-time BER estimate as the received power is varied via a
slider. The BER_TK subnetwork updates every 500 samples; the first value will be at 500-
Tsave, (e.g., for Tsave =100), the display will update at 400, 900, 1400, et cetera. The
transmitter and receiver are inside subnetworks, rather than at the top level design. A
berMC measurement is also provided, for determining BER vs. a swept parameter such as
Prx or Eb/No.

For BER vs. Eb/No, the AddNDensity component is set via an expression to the correct
noise density for each sweep point, using:
NoiseDensity=Prx-10*log(DataRate)-EbNo
where Prx is the signal power, DataRate is in bits/sec and Eb/No is in dB.
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In the following graph, EbNo is swept for 3 simulations at various values of BT. The 3
datasets are combined into one plot.

 

 Bluetooth Interference by 802.11 WLAN Signals 
WLAN systems share the same 2.4 GHz band as Bluetooth. At present, the 802.11b
system is operational in many regions, using direct-sequence spread-spectrum (DSSS)
modulation. A new mode based upon the 802.11a specification, which uses OFDM
(Orthogonal Frequency Division Multiplexing) in the 5 GHz band, has been proposed for
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use in the 2.4 GHz band and named 802.11g . Therefore, it is of interest to be able to
investigate the effects of both of these signals on Bluetooth performance. Two test
benches are provided for this purpose. However, band-limited noise may be used as an
approximate interference source and has been provided as an alternative.

Note
The 802.11b and 802.11a signal sources require the 5-GHz WLAN Design Library.

 

 Bluetooth_with_80211b_Interference

This test bench provides an interactive slider that varies the power of the interferer as an
EYE diagram is presented. Measurement items using the Agilent 89600 Vector Signal
Analyzer (available only on PC platforms) are also provided along with setup files; these
allow for demodulation and analysis of the Bluetooth and/or 802.11b signals in the
interactive mode. Spectrum and BER measurements are also provided.

Note
Simulation time will increase significantly if less than 256 MB of RAM are available.

 Bluetooth_with_80211g_Interference 

This test bench provides an interactive slider that varies the power of the interferer as an
EYE diagram is presented. Measurement items using the Agilent 89600 Vector Signal
Analyzer (available only on PC platforms) are also provided along with setup files; these
allow for demodulation and analysis of the Bluetooth and/or 802.11g signals in the
interactive mode. Spectrum and BER measurements are also provided.
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 Test Benches and Subnetworks  
Following are details on the available test benches and subnetworks.

 Basic System Test Benches 

TEST_TX_SPECTRUM The spectrum of the transmitter can be simulated here. The
effects of phase noise and Gaussian filter quantization can be observed and compared to
the allowed spectral template for various standards.

TEST_EYE This is a quick simulation to observe the eye diagram with the combined
effects of the transmitter and the complete receiver.

TEST_TX_RX_EYE The eye diagram corresponding to the detailed-model (full transmitter
and lowIF-receiver with phase noise and filters) end-to-end link can be simulated in this
design.

 Component/Subnetwork Evaluations 

SHAPED_DATA This design models a 2 or 4 level Gaussian filtered data source. It
includes an initial 2 level training sequence. Only the 2 level mode is applicable to
Bluetooth.

SLICER This design extracts the average level of a de-modulated analog signal and uses
this level as the slicing reference to a comparator input. The incoming analog signal is
sliced into digital bits by the comparator. The slicer behavior is depicted in the display
SLICER.

TEST_CHANNEL_FILTER The combined behavior of the highpass DC notch filters and
the complex channel filter is simulated in this design.

TEST_FILTER_COMPLEX Complex channel filter behavior is simulated in this design.

TEST_FILTER_COMPLEX_TIME The time domain response of the complex channel filter
is simulated in this design.
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TEST_FILTER_IMPULSE The impulse response of circuit level and system level lowpass
Bessel filters are compared in this simulation. These lowpass Bessel filters were used in
the design of the bandpass complex Bessel filter. The system level model of the filter was
preferred to speed the simulation; however, it needed an impulse response that was
identical to that of the circuit level filter model.

TEST_GAUSSIAN_FIR_FILTER The Gaussian filter is implemented digitally as a 17-tap
FIR filter with a 6-bit word length for each tap. The impulse response of the filter is
simulated in this design. The impulse response is saved to a file. Data from this file is then
used to define the tap coefficients of a FIR filter. The display TEST_GAUSSIAN_FIR_FILTER
shows the impulse response.

TEST_LOWIF_FILTER_DEMOD This test bench is used for comparing and optimizing the
combination of the channel filter along with various types of poly phase FM demodulators.

TEST_LOWIF_FMDEMOD Similar to the TEST_LOWIF_FILTER_DEMOD test bench, this
design investigates the effect of a polyphase harmonic suppression band pass filter at the
output of the hard limiters.

TEST_LOWIF_RECEIVER Similar to the TEST_LOWIF_FILTER_DEMOD test bench, with
this design the entire receiver chain is investigated.

 VCO/PLL (Phase Locked Loop) Investigations 

TEST_PLL_SS RF synthesizer reference frequency spurs that occur due to a charge pump
mismatch can be observed in this harmonic balance steady state simulation.

TEST_PLL_TR The transient response of the RF synthesizer is simulated in this test
bench.

TEST_PLL_TR_linear This is the main test bench for optimizing the RF synthesizer
parameters. The loop filter components are defined in terms of the parameters z (related
to damping constant) and fn (related to loop bandwidth). The various results are shown in
displays beginning with TEST_PLL_TR_linear.

 Multipath Propagation Test Benches 

TEST_MULTIPATH_ IMPULSE The impulse response of the multi-path channel is
simulated in this design. The frequency response of the channel is obtained, with and
without averaging done over any given modulation bandwidth, (e.g., 1 MHz for
Bluetooth). The results are shown in the display TEST_MULTIPATH_ IMPULSE. At
frequencies where there is a large relative channel loss without averaging, one can expect
severe intersymbol interference due to multi-path. It can also be seen that the correlation
bandwidth is approximately the inverse of the RMS delay spread.

TEST_MULTIPATH_POWER This design varies the channel snapshot, and measures the
corresponding modulated signal average power at the output of the channel. The
corresponding RMS delay spread values are also available. The display
TEST_MULTIPATH_POWER_200_50_seed shows the simulation results for a 200 nsec
delay spread using tap spacing of 50 nsec. A large number of channel snapshots were
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taken for the simulation. The pdf and cdf distributions of the multi-path loss are also
shown.

TEST_MULTIPATH_EYE This design shows the TK plot of the FM demodulated eye
diagram under multi-path conditions. The corresponding multi-path tap coefficients and
RMS delay spread values are also shown.

TEST_MULTIPATH_ EXPONENTIAL This simulation shows the variations in both the
mean power and the instantaneous modulated power for various channel snapshots, along
with the corresponding delay spreads.

TEST_MULTIPATH_BER This simulation measures the BER for various channel
snapshots. It is useful for computing the channel outage when the signal-to-noise ratio is
large. See display TEST_MULTIPATH_BER for one particular channel snapshot. It shows
the eye diagram, the channel snapshot, the recovered and transmitted bits, the BER, and
the RMS delay spread. For channel outage simulations, only the BER should be enabled
and the seed and/or frequency varied over a large number of points.

TEST_MULTIPATH_BER_AWGN Similar to TEST_MULTIPATH_BER, it includes additive
white Gaussian channel noise. The input signal power level to an ideal receiver (0 dB noise
figure) can be set. It shows the BER for both channel noise and multi-path. For channel
outage simulations, only the BER should be enabled, along with the channel power
measurement if required. For an example, see display TEST_MULTIPATH_BER_AWGN (100
nsec delay spread simulation for channel outage) in which the signal power was set 3 dB
above the 1% sensitivity level (AWGN case without multi-path).

TEST_MULTIPATH_BER_NOFILT Similar to TEST_MULTIPATH_BER, this design does
not include a channel filter. It shows the ideal BER under large signal-to-noise conditions.

 System Compliance Tests 

TEST_RECEIVER_ADJ The receiver adjacent channel rejection is simulated in this test
bench. Notably, the rejection at alternate channel frequency, the image frequency, and
the alternate channel-to-image frequency are simulated with this test.

TEST_RECEIVER_CCR The co-channel rejection of the receiver can be simulated with
this test.

TEST_RECEIVER_TEST_INTERMOD The effects of two-tone jammers due to third order
receiver non-linearity and the reciprocal mixing of these jammers due to phase noise are
simulated with this test.

TEST_RECEIVER_SENSITIVITY The receiver sensitivity in an additive white Gaussian
noise channel at -174 dBm/Hz is simulated in this design.

TEST_RECEIVER_IP2 The effect of out-of-band pulsed jammers on the receiver
sensitivity is modeled in this design. The pulsed jammers produce pulsed DC offsets in the
baseband quadrature signal paths. The relative power of the jammer and the co-channel
rejection of the receiver are the variables that can be set in the top level simulation. Thus,
the required IP2 is computed and used in the top level BER simulation.
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TEST_MR2_RECEIVER_SENSIVITY This test bench implements the 2 Mbps mode using
interactive control to view EYE diagrams, output data and a real-time BER estimate as the
received power is varied via a slider. It may also be configured for BER using Importance
Sampling . The transmitter and receiver are inside subnetworks, rather than at the top
level design. A berMC measurement is also provided, for determining BER vs. a swept
parameter other than Es/No, such as Prx.

TEST_MR3_RECEIVER_SENSIVITY This test bench implements the 3Mbps mode using
interactive control to view EYE diagrams, output data and a real-time BER estimate as the
received power is varied via a slider. The transmitter and receiver are inside subnetworks,
rather than at the top level design. A berMC measurement is also provided, for
determining BER vs. a swept parameter such as Prx or Eb/No.

 Bluetooth with 802.11 Interference Test Benches 

Bluetooth_with_80211b_Interference This test bench provides an interactive slider
that varies the power of the interferer as an EYE diagram is presented. Measurement
items using the Agilent 89600 Vector Signal Analyzer (available only on PC platforms) are
also provided along with setup files; these allow for demodulation and analysis of the
Bluetooth and/or DSSS 802.11b signals in the interactive mode. Spectrum and BER
measurements are also provided.

Bluetooth_with_80211g_Interference This test bench provides an interactive slider
that varies the power of the interferer as an EYE diagram is presented. Measurement
items using the Agilent 89600 Vector Signal Analyzer (available only on PC platforms) are
also provided along with setup files; these allow for demodulation and analysis of the
Bluetooth and/or OFDM 802.11g signals in the interactive mode. Spectrum and BER
measurements are also provided.

 Subnetworks  

AGC This block is used at the output of the MULTIPATH_EXPONENTIAL block to set the
mean output power to a fixed level, instead of letting it vary with each channel snapshot.
It measures the mean power of the signal coming from the MULTIPATH_EXPONENTIAL
block in a small time window, then it adjusts the gain to set the mean power at the design
level.

AWGN CHANNEL Models the thermal noise of an RF channel at -174 dBm/Hz.

Note
AddNDensity, a component available in recent releases of ADS, may be used in placed of
AWGN_CHANNEL. It allows the Noise Density to be directly specified in dBm/Hz.

BER_TK Provides real-time calculation of Bit Error Rate by exclusive-OR comparison of
two bit streams. Input data should be downsampled to 1 sample per bit. Requires top-
level variables Tsave and bitRate.

BroadBandNoiseSource80211b Provides a filtered noise source that approximates the
802.11b signal; for use when the WLAN Design Library is not available, or when system
resources prevent use of the 802.11b signal source.
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BroadBandNoiseSource80211g Provides a filtered noise source that approximates the
802.11g signal; for use when the WLAN Design Library is not available.

CLOCK_RECOVERY Used for bit-timing recovery and sampling of sliced data in the
receiver. This subnetwork extracts the bit timing from an initial stream of data, and then
freezes the recovered block phase after Ntrainer_sym bits. It also samples the de-
modulated bits at the middle point of each using the recovered clock.

DEMFM_OHZ A zero-IF polyphase FM demodulator that includes a down converter from
low-IF to zero-IF.

DEMFM_BESS_MULT A delay and multiply polyphase FM demodulator using a Bessel
filter to implement the delay. This unique method provides exceptional performance when
compared to the other demodulators.

DEMFM_DAMCKT A differentiate and multiply polyphase FM demodulator at the
Analog/RF circuit level.

DEMFM_DELAY_MULT A system level delay and multiply polyphase FM demodulator.

DEMFM_IQDIGITAL A polyphase digital FM demodulator.

FILT_HP_50KHZ N1 A first-order highpass filter generated from the DSP filter designer
in ADS. It is used in RECEIVER to remove DC following down-conversion.

FILT_LP_N1 A first-order lowpass filter.

FILTER_BESSEL_COMPLEX A polyphase bandpass filter with Bessel response.

FILTER_BESSELckt A circuit level (Analog/RF) subnetwork used in
FILTER_BESSELckt_COMPLEX.

FILTER_BESSELckt_COMPLEX A complex filter subnetwork used in
DEMFM_BESS_MULT.

FILTER_CHEB_COMPLEX A complex filter subnetwork used as a channel filter in
RECEIVER.

MEDIUM_RATE_2_TRANSMITTER A 2Mbps transmitter using Pi/4-DQPSK modulation
with a variable-length GFSK preamble.

MEDIUM_RATE_3_TRANSMITTER A 3 Mbps transmitter using 8-DPSK modulation with
a variable-length GFSK preamble.

MIXER_COMPLEX A complex mixer used in the system-level implementation of
polyphase bandpass filters.

MULTIPATH_EXPONENTIAL This design implements an exponential power decay multi-
path channel model that is widely used for indoor propagation. The mean excess delay
and tap delay can be specified in microseconds. Each tap coefficient has a Rayleigh power
distribution and a uniform phase distribution. For a specified value of time Tburst, the
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channel snapshot is kept fixed. For the next Tburst duration, a new channel snapshot is
taken. The tap coefficients for each snapshot, the corresponding values of the RMS delay
spread and the mean excess delay are all available. TK plots for these measurements can
also be enabled.

MULT_RF_BB A subnetwork used in MULTIPATH_EXPONENTIAL.

MULTIPATH_TAP_C A subnetwork used in MULTIPATH_EXPONENTIAL to generate
random noise and phase characteristics according to the exponential tap coefficients.

OSC_PN A system-level RF oscillator with phase noise.

OSC_PN_FMMOD A baseband phase noise generator used as modulation input voltage to
an FM modulator.

PLL_TR_linear Used in TEST_PLL_NOISE and TEST_PLL_TR_linear.

POWER Output is a signal that has a value equal to the input signal power in dBm. It is
useful in evaluating the effect of multi-path fading.

POWER_GATED Time-gated version of POWER.

TRANSMITTER This transmitter is used in most test benches. It is constructed using
SHAPED_DATA and OSC_PN_FMMOD, plus an ideal FM modulator. Top-level parameters
include the phase noise level and Q.

RECEIVER The Bluetooth receiver has a front-end low-noise amplifier that models the
noise figure and the third-order intercept point. It is followed by a quadrature amplitude
demodulator that includes the phase and gain imbalance. The local oscillator for this
demodulator/down converter includes the phase noise. The output of the quadrature
amplitude demodulator is a 1 MHz low IF complex signal comprising the in-phase and
quadrature phase signals. These signals are highpass filtered to remove DC offsets due to
local oscillator self mixing, and to remove time varying DC offsets as a result of second-
order non-linearity effects on out of band pulsed jammers. After the highpass filters, there
is a complex channel filter with quadrature inputs and outputs. This filter is centered at 1
MHz and has an asymmetric positive and negative frequency response. The quadrature
outputs of the channel filter are hard limited and then demodulated by a complex FM
demodulator. This FM demodulator can be implemented in several ways. The preferred
solution is to have a complex Bessel filter that implements a delay, with the delay signals
cross-multiplied with the input signals and then summed at the output. The combination
of the complex channel filter and this Bessel filter have to be carefully designed to produce
the minimum distortion of the de-modulated signal. The demodulator and signal have
unwanted high-frequency components that are removed by the data filter. The data slicer
then converts the demodulated analog signal into digital bits.

RECEIVER_IP2 The effect of out of band pulsed jammers on receiver sensitivity is
modeled in the RECEIVER_IP2 design, otherwise similar to RECEIVER. The pulsed
jammers produce pulsed DC offsets in the baseband quadrature signal paths. The relative
power of the jammer and the co-channel rejection of the receiver are variables that can
be set in the TEST_RECEIVER_IP2 top-level simulation. Based on this, the required IP2 is
calculated and used in the top level BER simulation.
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RECEIVER_MEDIUM_RATE A composite subnetwork which contains receivers for GFSK
and both medium rate formats.

SHAPED_DATA This subnetwork implements both 2 and 4 level pulse shaping for GFSK
modulation. A {10101010.....} preamble, its length determined by the Preamble
parameter defined in a VAR block in the top-level design, is inserted at the start of
simulation.

Note
This component has been slightly modified in Version 2.1.1 in that a IntToFloat component has been
inserted between the Bits and Trainer components. Under some conditions, ADS will report an error
concerning signal types without this added component.

sub_80211g_Source Part of the 802.11g Signal Source

sub_80211b_5p5Mbps_CCK_Source Part of the 802.11b Signal Source

sub_CRC_Generator, sub_DataCounter and sub_ScrambleWithReset Used within

sub_80211b_5p5Mbps_CCK_Source
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